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The Kodak 14250, i4650 and i4850 Scanners provide the ability to
process scanned images to improve their quality by using image
processing features.

Image processing refers to features of the scanner that allow you to
automatically adjust each image that may improve the resulting images
(e.g., correcting any skew in the fed document, cutting the edges of the
image off to remove unneeded borders or cleaning up extraneous
“noise” on the image).

The ISIS driver is software that communicates with the scanner. This
driver is created and maintained by EMC Captiva and is provided with
the scanner by Kodak Alaris Inc. This driver can be used to interface
with many scanning applications that support ISIS drivers.

The information in this guide provides descriptions of the features on
the tabs of the ISIS driver windows. The same features should be
available on the user interface of the scanning application you are
using.
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Starting the Scan NOTE: The Scan Validation Tool is provided by Kodak Alaris and is a
Validation Tool diagnostic tool only. Kodak Alaris does not support the use of
the Scan Validation Tool as a scanning application.

1. Select Start>Programs>Kodak>Document Imaging>Scan
Validation Tool.

TW.-'-‘«INDSM

Drivers:

FODAK Scanner: iduhll

2. Select ISIS for the Driver Type and the KODAK Scanner i4250/
i4650/i4850 as the driver and click OK. The main Scan Validation
Tool window will be displayed.

|H- S PTINEEEEELS

3. Click the Setup v—‘ﬁ icon. The Setup dialog box will be displayed.

Comprezsion

Frant Calar:

Front Bitonal:

Fear Color:

Fear Bitonal:

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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The Scan Validation
Tool dialog box

4. Click ISIS. The Preset Configurations dialog box will be displayed.
This dialog box maintains a list of saved driver settings.

You can Save, Delete or Import a preset by clicking one of the Preset
Configuration icons; or you can select/modify a predefined preset
that is shown in the Preset Name list box.

[ KODAK 14250 on None

Prezet Configurations

CIE3|E)

Freszet Mame

[Default]
Black and‘white Perfect Page Document

Color Perfect F‘aie D ocument

D escription

Default zettings.

Properties

[ Image. .. ] [ Scanner...

Cancel ]

5. Click Image to configure settings associated with the image.

The Scan Validation Tool (SVT) allows access to all the features of the
scanner and is a good way to verify that the scanner is working
properly. The Scan Validation Tool allows you to verify scanner
functionality using the ISIS Driver.

~ Scan Validation Toel - KOD.

— L_'IL

$|O@GO|v|&Ww|a|C

NOTE: There are many full featured applications that support the
Kodak i4x50 Scanners. The Kodak Capture Pro Software
Limited Edition scanning application that is included with this
scanner is a good choice for basic scanning. Kodak Capture Pro
Software Limited Edition can be upgraded to the full version of
Kodak Capture Pro Software as your scanning needs increase.

A-61838/ISIS July 2016



Toolbar buttons

L}

- Setup — displays the user interface for the selected driver.

. g
> Start Scanning — scans the documents in the input elevator.
a1 Scan One Page — scans only one page.
() Stop Scanning — ends the scan session.
» Change — switches between the TWAIN Datasource and ISIS
Driver.

Destination — allows you to select a directory to store scanned

=— images and their file names. This option is not available for the
ISIS Driver.

'.5" Delete — deletes the destination files.

ﬁ License Key — displays the License Key window.

No Image Display mode — closes the Image Viewer window
(no images will be displayed).

il One Image Display mode — displays one image at a time.

Two Image Display mode — displays two images at a time.

W
LA

Four Image Display mode — displays four images at a time.
Eight Image Display mode — displays eight images at a time.
ff TWAIN Settings — displays the TWAIN Settings screen.

0 About: displays the scanners’ version and copyright information.

The following sections provide descriptions and procedures for
configuring Image settings. See the section later in this chapter entitled,
“Configuring Scanner settings” for scanner configuration procedures.
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Configuring Image
settings

The main ISIS Driver window provides a set of several tabs for

configuring images. You can select each of these tabs and make any
choices necessary to meet your scanning needs.

NOTE: The Image Mode, Camera, Mode and Toggle Patch selections

are available on all of the Image tabs (e.g., Main, Layout, Image
Processing, etc.).

Properties for KODAK i4250 on E

Preset: [Defautt][2]

Image Mode Background I Image Edge Fill I Blank Image Detection I Barcode Reading I About |
7[Nnrrna| v] Main | Layout I Image Processing I Auto Color Detect I Dropout I Adjustments |

Camera: Dotz per inch:

Front Image #1 |0

O Front Image #2

Cropping:

[ Fixed To Tranzport

Binarization:
[ iT hresholding

Mode:

Black and White Threshold
Grayscale

Color
Auto Detect Grayscale
Auto Detect Color

LContrast

Toagle Patch: 50
| Off

Image Mode — select one of the following options:

* Normal — typically for a document, one image is created for the front
side and another image is created for the back side. Select this
option if you want the front and back side to be individual images.

* Merged — select this option if you want one image that contains both
the front side and back side of the document. Image Merged options

are: Front on Top; Front on Bottom; Front on Left or Front on
Right.

Camera — the selections in the Camera list displays the available
sides (front and back) of an image where you can define individual
image processing values. Options include: Front Image #1, Front
Image #2, Back Image #1 and Back Image #2.

The Kodak Scanner drivers allow you to control the camera settings

independently. Some settings apply only to black and white images,
others apply to color/grayscale images.
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Mode — select one of the following modes:

« Black and White: if you want your electronic image to represent all
elements of your document in black and white.

» Grayscale: if you want your electronic image to have a range of
varying shades of gray from black to white.

» Color: if you want your electronic image to be in color.

» Auto Detect Grayscale: sets auto color detect for grayscale. See
the section entitled, “Auto Color Detect tab” for more information.

» Auto Detect Color: sets auto color detect for color. See the section
entitled, “Auto Color Detect tab” for more information.

Toggle Patch — indicates you want to tell the scanner, via a toggle

patch document, if the document is color/grayscale or black and white.

» Off: no patches will be used.

» Same Side: only the side which recognizes the patch sheet will
toggle.

* Both Sides: a patch will be recognized on either the front or the back
side and both sides will toggle.
Buttons — the buttons on the bottom of the window apply to all tabs:

» Copy — this function is only available when scanning two-sided
documents. The Copy button provides a convenient way to set up the
color, grayscale or black and white image settings on one side and
transfer them to the other. For example, if you highlight and set up
Front Image #1, you can use the Copy button to duplicate those
settings for Back Image #1.

» OK — saves the values set on all tabs.
» Cancel — closes the window without saving any changes.

» Help — displays on-line help about the options available on the
selected window.

» Default — resets the values on all tabs to the default settings.
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Main tab The Main tab provides the following options:

Properties for KODAK 14250 on N E

Preset: [Default]2]

Background I Image Edge Fill I Blank Image Detection I Barcode Reading I About |

Image Mode
Main | Layout I Image Processing I Auto Color Detect I Dropout I Adjustments |

[ Momal - ]

Camera: Dotz per inch:

Front Image #1 |20

[ Front Image #2 Cropping:

[ Fixed To Transport

Binarization:
[iThresholding

Mode:
Thveshold
Grayscale

Color

Auto Detect Grayscale
Auto Detect Color

LContrast

Toggle Patch: -50
| Off

Dots per inch (dpi) or resolution — indicates the scanning resolution,
which largely determines the quality of the scanned image. The greater
the resolution, the better the reproduction. However, scanning at a
higher resolution also increases scanning time and file size.

Select a resolution value from the drop-down list. The default is 200 dpi.
Available resolutions are: 100, 150, 200, 240, 250, 300, 400, 500 and
600 dpi.

Cropping — allows you to capture a portion of the document being
scanned. All cropping options can be used with color/grayscale and
black and white images. Front and Back cropping are independent,
however, for simultaneous scanning, color/grayscale and black and
white cropping must be the same per side. Only one cropping option
can be assigned per image.

» Automatic: dynamically adjusts the cropping window for different
document sizes based on the edges of the image.

» Aggressive: eliminates any residual black border on any image
edges. In order to achieve this, there is a possibility that a small
amount of image data from the edge of the document may be lost.

» Fixed to Transport: (used for batches of same-sized documents)
allows you to define the area to be imaged. Fixed to Transport
cropping is used in conjunction with paper size and page layout and
assumes you are center-feeding your documents. If you are not using
center feeding, you must select the Layout tab to define your scan
area. See the section entitled, “Layout tab” later in this guide.
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* Relative to Document: (zone processing): (used for batches of
same-sized documents) — zone processing is a floating fixed crop
window (the zone) located relative to the upper left corner of a
document. It allows you to select an area on the document to be
delivered in either color/grayscale or black and white format (a
separate window for both black and white and color/grayscale may
be defined). Different parameters may be selected for both the front
and back of the image.

This option may be used in conjunction with Automatic cropping
where a separate color/grayscale or black and white area to be
saved is desired. It is useful in applications where a photograph,
signature, embossment or seal appears in a consistent area for an
application (you may want that small area in color/grayscale and the
rest in black and white). To define a zone, select the Layout tab.

Binarization — these options work on grayscale images and outputs a
black and white electronic image. Their strength lies in the ability to
separate the foreground information from the background information
even when the background color or shading varies, and the foreground
information varies in color quality and darkness. Different types of
documents may be scanned using the same image processing
parameters and results in excellent scanned images.

» iThresholding: allows the scanner to dynamically evaluate each
document to determine the optimal threshold value to produce the
highest quality image. This allows scanning of mixed document sets
with varying quality (e.qg., faint text, shaded backgrounds, color
backgrounds) to be scanned using a single setting thus reducing the
need for document sorting. When using iThresholding, only Contrast
can be adjusted.

» Fixed Processing (FP): used for black and white and other high
contrast documents. If Fixed Processing is selected, only Brightness
can be adjusted.

» Adaptive Thresholding (ATP): separates the foreground
information in an image (e.g., text, graphics, lines, etc.) from the
background information (e.g., white or non-white paper background).
When using Adaptive Thresholding, Brightness and Contrast can be
adjusted. Use this option when scanning similar type documents.

Threshold (Brightness) — this option is available when you select
Fixed Processing or Adaptive Thresholding (ATP). This option
allows you to change the black and white image to be darker or lighter.
The higher the threshold value, the darker the image. Use the slider to
select a value from 0 to 255. The default is 90.

Contrast — adjusts how much of the faint detail you want to see in the
output image. The higher the contrast value, the more faint lines will be
shown in the image. The lower the contrast value, the clearer (or less
detailed) the output image will be. If contrast is set too high, you may
get lines or black areas in your output image that you do not want. If the
contrast is set too low, some letters or lines may not show in the output
image. Select a contrast value from -50 to 50. The default is 0.
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Layout tab The Layout tab provides the following options:|

Properties for KODAK 4850 on 5TI - 0000 4
Preset: Color Perfect Page Document
Image Mode Background  Image Edge Fil  Blank Image Detection  Barcode Reading  About

Mormal Main Layout  Image Processing  Auto Color Detect  Dropout  Adjustments

Camera: Page Size:
Front Image #1 Scariner's Masimum
O Front Image #2
Back Image #1 Image Orientation
[ Back Image #2 Partrait R
Landscape E ;E j|
Mode: Autarnatic ~ —
Black and White
Grayscale
Auto Detect Grayscale Page Orientation
Auto Detect Color @ Tap edge first
Bottom edge first
() Left edge First
Toagle Patch: Right edge first
Off LV
Scan Area...
Copy Cancel Help Default

Page Size — the default page size is set when a scanner is first
selected. You can choose a different page size using the drop-down list.
Page size should be set to the Scanner’s maximum when using the
Automatic or Aggressive cropping option.

Image Orientation

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

* Automatic — the scanner will analyze each document to determine
how it was fed and will rotate the image to the proper orientation.

» Automatic - default to 90: the scanner will analyze the content of
each document to determine how it was fed and will rotate the image
to the proper orientation. If the scanner cannot determine how the
document was fed, it will rotate the image 90 degrees.

* Automatic - default 180: the scanner will analyze the content of
each document to determine how it was fed and will rotate the image
to the proper orientation. If the scanner cannot determine how the
document was fed, it will rotate the image 180 degrees.

» Automatic - default 270: the scanner will analyze the content of
each document to determine how it was fed and will rotate the image
to the proper orientation. If the scanner cannot determine how the
document was fed, it will rotate the image 270 degrees.
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Page Orientation — allows you to select the way you place your
documents in the scanner, Top edge first, Bottom edge first, Left
edge first or Right edge first.

Scan Area — displays the Scan Area dialog box. The Scan Area
options are only available for images when the cropping option is Fixed
to Transport or Relative to Document. See the next section entitled,
“The Scan Area dialog box” for more information.

Scan Area dialog box The Scan Area dialog box allows you to define the amount of image
data which is returned to the host.

NOTES:

» Select the Image Mode (either Normal or Merge) based on the
cropping option selected on the Main tab. If you select Normal, select
the side(s) (i.e., Front Image #1, Front Image #2, Back Image #1
and/or Back Image #2) to be defined.

If you Select Merge, select the orientation of the merged images (i.e.,
Front on Top, Front on Bottom, Front on Left or Front on Right).
The scan areas defined for all camera selections are independent.

e The Scan Area dialog box is only available when Fixed to Transport
or Relative to Document is selected on the Main tab.

When you select Scan Area on the Layout tab, the Scan Area dialog
box.

Page Size:

l Scanner's Maximum

FPage Layout

Partrait
() Landscape

]

]
I

0
0
Wickh: 81/2"

Height: 14"

Units:

[ Inches

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Page Size — the default paper size is set when a scanner is first
selected. You can choose a different paper size using the drop-down
list.

NOTE: Page Size also appears on the Layout tab. If you make a
change on the Scan Area dialog box, the same selection
appears on the Layout tab and vice versa.

Page Layout

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

Area

* Snap — enable this option to control the dimensions of the preview
area to fixed 0.3175 cm (1/8-inch) increments. This option is not
available in Pixels mode.

» X: the distance from the left end of the scanner to the left edge of the
scanning area.

* Y: the position from the top end of the document to the top end of the
scanning area.

» Width: the width of the scanning area.
» Height: the height of the scanning area.

Units — select whether you want the area to be defined in Pixels,
Inches or Centimeters.
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Image Processing tab The Image Processing tab provides the following options:

- -
Properties for KODAK i4250 on [

Preset: [Defauttl[2]

Image Mode | Background I Image Edge Fill I Blank Image Detection I Barcode Reading I About |
I = Main | Layout | Image Processing | Auto Color Detect | Dropout | Adjustments |

[ MNomal

Camera: General Options

Frort Image #1 [ B arcode Image Enhancement

[ Front Image #2 [ Hale Fill

[ dd Barder
O Halftore Removal

O invert Image

Mode: M neskew
Black and White:

Grayscale Documnent Type

Color [Text with Graphics

Auto Detect Grayscale

Auto Detect Color

tedia Type

[ Plain Paper

Eetter

Muaize Filter

[ Lone Pixel

Text Enhancement

Thinning/T hickening:

General Options

» Barcode Image Enhancement — allows you to configure the
scanner so it will optimize the barcodes for reading by your
application. The scanner will automatically find the 1D and 2D
barcodes in a black and white image and will apply special image
processing to the barcodes to make them easier for barcode reading
after they are scanned. Barcode Image Enhancement does not affect
barcode reading that is enabled in the ISIS Driver, as the barcode
reading functionality that Kodak Alaris provides is performed using
high resolution grayscale data during image processing.

» Hole Fill — allows you to fill in the holes that are around the edges of
your document. The types of holes that are filled include: round,
rectangular, and irregularly shaped (e.g., double-punched or those
having a slight tear that could have occurred when the document was
removed from a binder).

NOTE: Do not turn Hole Fill on if you are scanning photos.

» Add Border — allows you to add a fixed amount of border to the left,
right, top and bottom edge of the image. This option is not available
when Aggressive is selected.

» Halftone Removal — enhances images containing dot matrix text
and/or images with shaded or colored backgrounds using halftone
screens and effectively eliminates noise caused by the halftone
screen.
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* Invert Image — allows you to select how the black pixels will be
stored in the image. By default the black pixels are stored as black
and the white pixels are stored as white. Turn this option on if you
want the black pixels stored as white and the white pixels stored as
black.

NOTE: You may want to change this option if your application
misinterprets the image data and stores your image in
reverse of what you expect.

» Deskew — automatically straightens a document within +0.3
degrees of the leading edge of the document. Deskew can detect up
to a 45-degree skew and correct up to a 24-degree angle at 200 dpi
or a 10-degree skew angle at 300 dpi. This option is only available
when Automatic is selected.

NOTE: To prevent data loss, the document must have all four
corners within the image path.

Document Type
» Text: when the documents you want to scan contain mostly text.
» Text with Graphics: when the documents you want to scan contain a

mix of text, business graphics (bar graphs, pie charts, etc.) and line
art.

» Text with Photographs: when the documents you want to scan
contain a mix of text and photos.

* Photographs: when the documents you want to scan are composed
mainly of photos.

Media type — allows you to select the type of paper you are scanning,
based upon the texture/weight. The options are: Plain Paper, Thin
Paper, Glossy Paper, Card Stock, and Magazine.

JPEG (Joint Photographic Editor Group) Quality — if you choose
JPEG compression, select one of the quality options:

» Draft: maximum compression which produces the smallest image
size.

» Good: a fair amount of compression but still produces acceptable
image quality.

» Better: some compression which produces decent image quality.

» Best: minimal compression which produces very good image quality.

» Superior: the least amount of compression which produces the
largest image size.
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Noise Filter
« None

» Lone Pixel: reduces random noise by converting a single black pixel
to white when it is completely surrounded by white pixels or by
converting a single white pixel to black when it is completely
surrounded by black pixels.

» Majority Rule: sets each pixel based on its surrounding pixels. The
pixel will become white if the majority of the surrounding pixels are
white and vice versa.

Text Enhancement — allows you to configure the scanner to improve
the appearance of text. Turn this option on if your document is mostly
text and the characters are disconnected or not smooth. This option
improves the readability of dot matrix printing and improves poor quality
characters if the font size and/or resolution is large/high enough.

NOTES:

» This may have no effect on small fonts and effectiveness may be
diminished if Thinning/Thickening is being used.

« If the font size is too small or the resolution is not high enough, this
option may cause characters to fill in.

Thinning/Thickening — allows you to make the lines and characters
appear to be thinner or thicker. Decreasing this setting will make the
lines and characters thinner/smaller. Increasing this setting will make
the lines and characters thicker/larger. The default is 0, no thinning or
thickening.
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Auto Color Detect tab The Auto Color Detect tab provides the following options:

= B
Properties for KODAK i4250 on ===
Preset: [Default][2]
image Mod | Background I Image Edge Fill I Blank Image Detection | Barcode Settings | About l
A i i Auto Color Detect i
= e Loy | mmge Pocessng | uto
Camera: Color Content
Front Image #1 [Eustom ']
O Front Image #2 Color Aot Color Threshold
[} 47 = ] 20=
1 200 1] 100
Mode:
Black and White Leamn
Grayscale Usze the learn rmode to determing the proper i
Calor Color Amount for detecting your colar
Auto Detect Grayscale documents. Set the Color Threshaold value
Auto Detect Color and click the Learn button to begin.
Amount Detected: 0

Threshold Detected: 0

Copy | [ ok ][ canced |[ Hep || Defaut

Color Content
« Off: this is the default. No color content will be detected.

» Low: documents requiring only a small amount of color to be saved
as color or grayscale images. Used for capturing documents that are
primarily black text with small logos, or contain small amounts of
highlighted text or small colorful photos.

* Medium: documents require more color, as compared with the Low
option, before they are saved as color or grayscale images.

» High: documents require more color, as compared with the Medium
option, before they will be saved as color or grayscale images. Used
for distinguishing documents containing medium- to large-size
colorful photos from plain black text. Photos with neutral colors may
require adjustments to the Color Threshold or Color Amount values in
order to be captured correctly.
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e Custom: allows you to manually adjust the Color Amount and/or
Color Threshold.

NOTE: When setting Auto Color Detect values, it is suggested that
you start with the Medium option and scan a typical job set. If
too many documents were returned as color/grayscale vs.
black and white, then change to the High option and re-run
the job. If too few documents were returned as color/
grayscale vs. black and white, then change to the Low option
and re-run the job. If none of these options provide the
desired result, select the Custom option to manually adjust
Color Amount and/or Color Threshold.

Color Amount: the amount of color that needs to be present in a
document before it will be saved as either color or grayscale. As the
value of Color Amount increases, more color pixels are required. Valid
values are 1 to 200.

Color Threshold: the color threshold or intensity (e.g., pale blue vs.
dark blue) at which a given color will be included in the color amount
calculation. A higher value indicates that a more intense color is
required. Valid values are 0 to 100.

Learn — allows you to calculate your settings based on representative
color documents scanned. Before selecting Learn, place at least 5
representative color documents in the input elevator. The documents
will be scanned and analyzed to determine the recommended Color
Amount.

NOTE: The Color Amount and Color Threshold sliders will be
updated automatically. If these values do not provide the
desired results with your document set, you may need to
manually adjust the Color Threshold.
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Dropout tab The Dropout tab provides the following options:

Properties for KODAK 14250 on Non:

Preset: [Defautt][2]

Image Mode | Background I Image Edge Fill I Blank Image Detection I Barcode Settings I About |
| Nommal | Main I Layout I Image Processing I Auto Color Detect | Dropout | Adjustments

Camera: Color Diropout

Front Image #1 Calar:

O Front Image #2 [Nnne v]

Mode:

Black and White
Grayscale

Caolor

Auto Detect Color

[ coy | [ ok ][ camcel |[ Hep |[ Defauk |

Color Dropout — used to eliminate a form's background so that only
the entered data is included in the electronic image (e.g., remove the
form’s lines and boxes). For black and white images, these settings
affect the grayscale version of the document which the scanner
analyzes to produce that electronic image.

» Color: select the desired dropout color.
- None

- Red

- Green

- Blue

- Orange

- Orange and red
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Adjustments tab The Adjustments tab provides the following options:

- -
Properties for KODAK i4250 an [

Preset [Default)[2]

Image Mode | Backaround | Image Edae Fil I Blank Image Detection I Barcode Reading | About | l
| | Main I Layout I Image Processing I Auto Color Detect I Dropout | Adjustments

[ Nomal ']

Camera Color Adjustment

(i 0

O Front Image #2

Brightness:

LContrast:

Mode: Sharpen:

Black and White
Grayscale Color Balahce

Auto Detect Grayscale
Auto Detect Color

Streak Filter
On

Color Adjustment — available options are:

For Black and White, Grayscale or Auto Detect Grayscale mode:
Available options are:

e (none)

* Manual

* Automatic

If you select Manual you can adjust the Brightness, Contrast and
Sharpen values.

» Brightness — changes the amount of white in the color or grayscale
image. The values range from -50 to 50.

» Contrast — changes how dark the darker areas are, and how white
the lighter areas are. The values range from -50 to 50.

» Sharpen — makes edges within the image more noticeable. The
values range from 0 to 3; 0 being the least amount of sharpening.

If you select Automatic, you can only adjust the Sharpen value.

NOTE: Color Balance is not available for Black and White, Grayscale
or Auto Detect Grayscale.
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For Color or Auto Detect Color mode:
Available options are:

* (none)

» Manual

e Automatic

If you select Manual you can adjust the Brightness, Contrast and
Sharpen values.

* Brightness — changes the amount of white in the color or grayscale
image. The values range from -50 to 50.

» Contrast — changes how dark the darker areas are, and how white
the lighter areas are. The values range from -50 to 50.

» Sharpen — makes edges within the image more noticeable. The
values range from 0 to 3; 0 being the least amount of sharpening.

If you select Automatic, you can only adjust the Sharpen value.

Color Balance — available options are:

* (none)

* Manual

« Automatic

e Automatic - advanced

If you select Manual you can adjust the Red, Green and Blue values
by dragging the slider bar to the left or right, entering a value in the text
box or using the up/down arrows.

* Red — changes the amount of red in the color image.
» Green — changes the amount of green in the color image.
* Blue — changes the amount of blue in the color image.

If you select Automatic, the scanner will analyze the documents to
produce the best possible image.

Automatic - advanced is for advanced users that want to further adjust
this option. Use the Aggressiveness slider bar to adjust the extent at
which the color balance is determined. Values range from -2 to 2.

Streak Filter — allows you to configure the scanner to filter vertical
streaks from your images. Streaks are lines which may appear on an
image and are not part of the original document. Streaks may be
caused by contaminants on your documents (e.g., dirt, dust or frayed
edges) or by not following the recommended cleaning procedures for
your scanner. Adjust the extent at which the streaks are filtered by
moving the slider bar from -2 to 2. The default is O.
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Background tab The Background tab provides the following options:

2]
Properties for KODAK i4250 on |t S|

Preset: [Defaut]2]

Main I Layout I Image Processing I Auto Color Detect I Dropout I Adjustments |
Background | Image Edge Fill I Blank Image Detection I Barcode Settings I About |

Image Mode

Normal

Camer: Background Smaothing

O Front Image #2
Aggressiveness: G

-10 10

Mode: Foreground Boldness

Back and Wite Eoreground

rayscale
Calor
Auto Detect Grayscale
Auto Detect Color

NOTE: The options on the Background tab are not available for black
and white mode.

Background Smoothing — using this option for documents or forms
with a background color will help produce images with a more uniform
background color. This option improves image quality and may reduce

file size.
NOTE: Background Smoothing is not intended for use with
photographs.
Carter H. Selwick Carter H. Selwick
Supervising Architect Supervising Architect
Before After
* None

» Automatic: smooths up to three background colors.
» Automatic - advanced: for advanced users that want to further
adjust the Automatic option.
- Aggressiveness — allows you to adjust the extent at which the
background(s) are determined. The values range from -10 to 10.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Foreground Boldness — use this option for documents or forms
where you want the foreground (e.g., text, lines, etc.) to be more
prominent. When Foreground Boldness is enabled, gray and neutral
colors are darkened.

NOTE: Foreground Boldness is not intended for use with photographs.

Carter H. Selwick Carter H. Selwick
Supervising Architect Supervising Architect
Before After
* None

» Automatic: all foreground will be bolder.
* Automatic - advanced: for advanced users that want to further
adjust the Automatic option.
- Aggressiveness - allows you to adjust the extent at which the
foreground is determined. Values range from -10 to 10.

1
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Image Edge Fill tab This option fills the edges of the final electronic image by covering the
area with the specified color. Image Edge Fill is performed after all other
image processing options have been applied.

- B
e oo o e A ==
Preset: [Defautt][2]
Image Mode Main Layout | Image Processing I Auto Color Detect I Dropout I Adjustments |
Normal Image Edge Fil | Blank Image Detection I Barcode Settings I About |
Camera: Image Edge Fill
Front Image #1 Fill Color
Front Image #2 [Black ']
[] Frame Mode
Left: 0.00in
Mode: Bight: 0.00in
Black and White
Greyscale Iop: 0.00n
Auto Detect Grayscale -
Auto Detect Color rtiom 0.001n
[ copy | [ ok ][ cancel || Help |[ Defaut

Fill Color — allows you to select the color to fill the edges with.

* None

* White

* Black

» Automatic: the scanner will automatically fill the edges of the image
using the surrounding color.

* Automatic - include tears: in addition to filling the edges, the
scanner will also fill in tears along the edge of document.

When you select White or Black these options are available:

 If you check Frame Mode, an equal amount of the selected color
from the Image Edge Fill drop-down list will be filled in all on all sides
of the image.

* If you do not check Frame Mode, you can select a value in the Top,
Left, Right and/or Bottom area(s) from each side of the scanned
image to be filled.

NOTE: When using Image Edge Fill, be careful not to enter a value too
large as it could fill in image data that you want to keep.
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Blank Image Detection tab Blank Image Detection allows you to configure the scanner to not give
blank images to the scanning application. Select the image size (KB),
below which an image is determined to be blank. Images with sizes less
than the number you select will not be created. If you use this option,
you must specify a blank image size for each image type (Black and
White, Grayscale and Color) you want to delete. If you do not make an
entry in these fields, all images are kept.

- -
Properties for KODAK 4250 on N [

Preset: [Defautt][2]

Image Mode | Main I Layout I Image Processing I Auto Color Detect I Dropout I Adjustments |
[ Normal | Background I Image Edge Fill | Blank Image Detection | Barcode Settings I About

Camera: Blank Image Detection

Front Image #1 Made

Front Image #2 [Content
Black and White

U

[ Grayscale

Mode:

Black and White
Grayscale

Auto Detect Grayscale
Auto Detect Color [ Colar

Learn Content

Usze the leam made ta determine Image content Amount.

Mode
» Off: all images are given to the scanning application.

» Size: images will be considered blank based on the size of the image
that would be given to the scanning application (i.e., after all other
settings have been applied).

» Content: images will be considered blank based on the document
content within the image. Select Black and White, Grayscale or
Color to choose the maximum amount of content that the scanner
will consider to be blank. Any image that has more content than this
value will be considered non-blank and will be given to the scanning
application. The values range from 0 to 100 percent.

Learn Content — allows the scanner to determine the content amount
based on the documents to be scanned. Click Learn to use this
function.

NOTE: Learn mode cannot be applied to both the front and back sides
simultaneously. You must select the side you want to configure.
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Barcode Reading tab The Barcode Reading tab allows you to configure the scanner to search

your images for barcodes and return the information to the scanning
application.

Preset: [Defaut]2]

Image Mode | Main I Layout I Image Processing I Auto Color Detect | Dropout | Adjustments
-[ Normal v] | Backaround I Image Edae Fill I Blank Image Detection | Barcode Reading -About |

Configure Barcodes

Camera:

5| Front Image #1 [ 0n

O Front Image #2

3of9 CODABAR
[ Code 128 [VIE&MH 13

EAN 8 UPC A
Mode:

UPCE [C]PDF 417

Black and White
Grayscale 2 of & Interleaved 0GR Code
Calor

Auto Detect Grayscale
Auto Detect Color Hows many: 1 -

Search Area

Entire Document v]

“width:
Height:

Configure Barcodes

» On: turns barcode reading on. When you select On, all barcode
types are selected. Deselect any of the barcode types you do not

want the scanner to search for.
- 30of9

-  Code 128

- EANS

- UPCE

- 2 of 5 Interleaved
-  CODABAR

- EAN 13

- UPCA

- PDF 417

- QR Code

 How many: select the number of barcodes the scanner will search
for.

* Orientation: select the orientation of the barcodes to search for.
Selections are: None, Horizontal, Vertical or Both.

NOTE: This is relative to the final image (i.e., after any cropping and
rotation has been applied).
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» Search Area: select the area of the image to search.

- Entire Document
- Part of Document: if selected, you can make an entry in the
following fields:
» Xs the distance from the left edge of the image.
* Y is the distance from the top edge of the image.
* Width and Height: the width and height of the area to search.

NOTES:

» These are relative to the final image (i.e., after any cropping
and rotation has been applied).

« If Part of Document is selected, the rules for top left to bottom
right barcode reading apply with the selected Region of
Interest.

* If Image Merge is selected, the barcode settings for the front
image will be applied to the merged front and rear image.

1
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About tab The About tab displays information about your scanner and driver.

Properties for KODAK i4250 on

Freset [Defaut])2]
Image Mode [ Main | Layout | image Processing | Auto Color Detect | Dropout | Adjustments |
Nomal Background | Image Edge Fill | Blank Image Detection I Barcode Settings ‘ About

Thig driver was wiitten to be
compatible with 1515[R] but
has nat been certified by EMC
Corporation

cheetah Version 1.1.11503.1002
KODAK 4000 Series Scanner

Mode: Copyright [c) 2014 EMC Corporation
Black and White QuickDriver Yersion 2.0.11311.21001
Grayscale

Device Information:

Auto Detect Grayscale
Auto Detect Color

EMC, Captiva and 515 are either registered trademarks or
trademarks of EMC Corporation in the United States and/or
ather countries. QuickDriver is a rademark of EMC
Corporation. All other trademarks used herein are the property
of their respective owners,

@ Copyright 2014 EMC Corporation. Al rights reserved

Copy | [ ok ][ Cancel |[ Help ][ Defauk
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Configuring Scanner

To access scanner settings from the ISIS Driver, go into the Scan
settings

Validation tool as described earlier in this guide and access the ISIS
driver.

Preset Configurations
x

Freszet Mame
[Default]
Black and *hite Perfect Page Document

Color Perfect Paie L ocument

Description

Drefault settings.

Properties

[ Image... J [ Scanner...

» Click Scanner to configure settings associated with the scanner. The
following sections provide descriptions and procedures for
configuring Scanner settings. See the section entitled, “Configuring

Image settings” earlier in this guide for image configuration
procedures.

1
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Scanner tab The Scanner tab provides the following options:

_
Properties for KODAK 4250 on N ==

Preset: [Defaut][2]

Scanner | Mutifeed Detection | Imprinter | Log | About |

Document Feeder
Paper Source:

ADF

FEeeder Position

[ Mormal

Automatically start transport

Sheet Counter

Timeout
On
{J 5
1 120 seconds

Besponsze:

[ Stop Scanning - ]

Intelligent Protection:
Action when paper jam ocours: :]

M aximum Length: 7
Power Saver:

Power Off:

Document Feeder

Paper Source

» Automatic: looks for paper in the ADF first. If there are no
documents in the input elevator, the scanner will scan from the
flatbed. This option is only available if a flatbed is attached.

» ADF: the input elevator is in the highest position. This selection is
recommended when you are scanning 25 sheets or less from the
input elevator.

* Flatbed: scanner will scan from the flatbed. This option is only
available if a flatbed is attached.

Feeder Position

* Normal: the input elevator is in the highest position. This selection is
recommended when you are scanning 25 sheets or less from the
input elevator.

* 100 Sheets: this selection is recommended when you are scanning
between 25 and 100 sheets from the input elevator.

» 250 Sheets: this selection is recommended when you are scanning
between 100 and 250 sheets from the input elevator.

» 500 Sheets: this selection is recommended when you are scanning
between 250 and 500 sheets from the input elevator.
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» Automatic - 100 Sheets: looks for paper in the input elevator first, if
there are no documents in the input elevator, the scanner will scan
from the flatbed. This selection is recommended when you are
scanning between 25 and 100 sheets from the input elevator. This
option is only available if a flatbed is attached.

» Automatic - 250 Sheets: looks for paper in the input elevator first, if
there are no documents in the input elevator, the scanner will scan
from the flatbed. This selection is recommended when you are
scanning between 100 and 250 sheets from the input elevator. This
option is only available if a flatbed is attached.

» Automatic - 500 Sheets: looks for paper in the input elevator first, if
there are no documents in the input elevator, the scanner will scan
from the flatbed. This selection is recommended when you are
scanning between 250 and 500 sheets from the input elevator. This
option is only available if a flatbed is attached.

Automatically start transport — if selected, the scanner will wait for
up to 10 seconds for documents to be placed in the input elevator
before scanning will begin. In addition, once the input elevator has been
emptied, the scanner will automatically resume scanning when paper is
placed in the input elevator. The scanner will wait the amount of time
specified by the document feeder timeout.

Sheet Counter — enter the number to be assigned to the next physical
sheet of paper entering the scanner. This is incremented sequentially
by the scanner and is returned in the image header.

Timeout — allows you to set the amount of time the scanner will wait
after the last document enters the transport before the transport timeout
action is taken. You can specify a time delay setting from 1 to 120
seconds.

Response — indicates the action that will be taken when the document
feeder timeout has been reached.

» Stop Scanning: scanning will stop and control will return to the
scanning application (e.g., ends the job).

» Pause Scanning: scanning will stop but the scanning application will
be waiting for additional images (e.g., stops the feeder). Scanning
may be resumed by pressing the Start/Pause button on the Operator
Control Panel. Scanning may be stopped by pressing the Stop
button on the Operator Control Panel or via the scanning application.

» Pause Scanning - wait for paper: scanning will stop but the
scanning application will be waiting for additional images (e.g., stops
the feeder). Scanning will be resumed automatically when
documents are added to the input elevator.
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Document Handling — allows you to select how the scanner
transports documents through the scanner. This affects how the
documents are fed into the scanner, how fast they move through the
scanner, and how they are placed in the output tray.

* Normal: no additional handling is performed. Best used when all
documents are similar in size.

» Improved Stacking: aids in controlling how the documents are
stacked/ordered in the output tray for mixed document sets. This
should work for the majority of mixed sets.

» Best Stacking: when your document set contains a great variability
in size, this option provides the best control of how the documents
are stacked/ordered within the output tray.

Intelligent Protection — allows you to select how aggressively the
scanner detects documents that enter the scanner incorrectly. This can
occur when documents are not prepared properly for scanning (e.g.,
stapled or paper clipped documents).

* None

* Normal: this is the recommended option as it provides a balance
between minimizing document damage and stopping the scanner
unnecessarily.

* Minimum: select this option if the scanner is stopping too frequently
on documents that you do not want it to detect.

NOTE: Documents may become more damaged before detection
occurs.

» Maximum: select this option to get the least amount of document
damage.

NOTE: This may cause the scanner to stop unnecessarily.

Action when paper jam occurs — allows you to select what happens
when the scanner detects a paper jam.

e Stop Scanning: scanning will stop and control will return to the
scanning application (e.g., ends the job). Verify that the paper path
has been cleared and restart the scan session from the scanning
application.

» Pause Scanning: if you want to automate the jam recovery option,
selecting Pause Scanning will cause scanning to stop but the
scanning application will be waiting for additional images (e.g., stops
the feeder). This option will allow you to recover from a document jam
faster, thus improve operator efficiency. When you clear the paper
path, scanning can be resumed by pressing the Start/Pause button
on the Operator Control Panel. Scanning can be stopped by pressing
the Stop button on the Operator Control Panel or via the scanning
application.

Maximum Length — select a value that indicates the length of the
longest document in your document set.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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NOTES:

» Not all combinations of settings are supported at the larger lengths
(e.g., resolution, color, grayscale, etc.). To allow for greater flexibility
with applications, the scanner will not generate an error until it sees a
document whose length is not supported.

» The scanner’s throughput may be reduced for larger lengths.

Power Off — allows you to set the amount of time, in minutes, the
scanner has to be in power saver mode before it automatically turns off.

Power Saver — allows you to set the amount of time the scanner (1 to
240 minutes) will remain inactive before the scanner goes into an idle
state. The default is 15 minutes.

Multifeed Detection tab Multifeed detection aids in document processing by detecting
documents that may go through the feeder overlapped. Multifeed can
happen due to stapled documents, adhesives on documents or
electrostatically charged documents. The Multifeed Detection tab
provides the following options.

- il
Properties for KODAK i4250 on M [
Freset: [Defaut][2]

- Multfeed Detection Imprinterl Log | About

tulti-Feed Detection

Ultrazonic Detection

Ultrazonic Detection

Sensitivity: b edium o
Left Center Right

Qff: @

Or: = ° @

Length Detection

Length Detection
b ax Length:
0.00 in

Action:

Ultrasonic Detection — check this option to set multifeed detection.

» Sensitivity — controls how aggressively the scanner will work to
determine if more than one document is fed into the transport.
Multifeeds are triggered by detecting air gaps between documents.
This allows multifeed detection to be used with job sets containing
documents with mixed thicknesses.

- Low: the least aggressive setting and is less likely to detect
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labels, poor quality, thick or wrinkled documents as multifed
documents.

- Medium: use Medium sensitivity if your application has varying
document thickness or labels attached to the document.
Depending on the label material, most documents with labels
should not be detected as a multifed document.

- High: the most aggressive setting. This is a good setting to use if

all documents are similar in thickness to 75.2 g/m? (20-Ib.) Bond
paper.
Three sensors cover the width of the paper path. In order for multifed
documents to be detected correctly, they must pass under one of these
sSensors.

» Left, Center, Right: this allows you to select which sensor(s) you
want to have turned on. For example, if you know that the left side of
the document has a “sticky” note on it, you can turn off the left sensor.

Length Detection — when enabled, you can select the maximum
length of the document that can be scanned without a multifeed being
detected. Length detection is used when scanning same-sized
documents to check for overlap. For example, if you are scanning A4
(8.5 x 11-inch) documents in portrait mode, enter a value of 28.57 cm
(11.25 inches) in the Max Length field. The maximum value is 35.56 cm
(13.99 inches).

Action — select what action you want the scanner to take when a
multifeed is detected. With all options, the condition will be logged in
the scanner.

e Stop Scanning: scanning will stop and control will return to the
scanning application (i.e., ends the job). Image(s) of the multifed
document will not be generated. Verify that the paper path has been
cleared and restart the scan session from the scanning application.

» Stop Scanning - generate image(s): scanning will stop and control
will return to the scanning application (i.e., ends the job). Image(s) of
the multifed document will be generated. Verify that the paper path
has been cleared and restart the scan session from the scanning
application.

» Stop Scanning - leave paper in path: scanning will stop
immediately (i.e., making no attempt to clear the paper path) and
control will return to the scanning application (i.e., ends the job).
Image(s) of the multifed document will not be generated. Clear any
documents from the paper path prior to restarting the scan session
from the scanning application.

» Stop Scanning - leave paper at exit: scanning will stop and the last
portion of the multifed document will be held at the transport's exit,
and control will return to the scanning application (i.e., ends the job).
Image(s) of the multifed document will not be generated. Clear any
documents from the paper path prior to restarting the scan session
from the scanning application.

« Continue Scanning: the scanner will continue to scan. Image(s) of
the multifed document will be generated.
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» Pause Scanning - generate image(s): scanning will stop but the
scanning application will be waiting for additional images (i.e., stops
the feeder). Image(s) of the multifed document will be generated.
Scanning may be resumed by pressing the Start/Pause button on
the Operator Control Panel. Scanning may be stopped by pressing
the Stop button on the Operator Control Panel or via the scanning
application.

» Pause Scanning - leave paper in path: scanning will stop
immediately (i.e., making no attempt to clear the paper path) but the
scanning application will be waiting for additional images (i.e., stops
the feeder). Image(s) of the multifed document will not be generated.
Clear any documents from the paper path prior to resuming the scan
session. Scanning may be resumed by pressing the Start/Pause
button on the Operator Control Panel. Scanning may be stopped by
pressing the Stop button on the Operator Control Panel or via the
scanning application.

» Pause Scanning - leave paper at exit: scanning will stop and the
last portion of the multifed document will be held at the transport's
exit, but the scanning application will be waiting for additional images
(i.e.,stops the feeder). Image(s) of the multifed document will not be
generated. Clear any documents from the paper path prior to
resuming the scan session. Scanning may be resumed by pressing
the Start/Pause button on the Operator Control Panel. Scanning may
be stopped by pressing the Stop button on the Operator Control
Panel or via the scanning application.

* Interactive Multifeed Recovery: scanning will stop but the scanning
application will be waiting for additional images (i.e., stops the
feeder). Images of the multifed document will be displayed on your
computer. You can accept these images or rescan to replace them.
You can make your selection on your computer or the scanner. Send
the images to your application and resume scanning by selecting
Accept. Selecting Rescan will discard the images and scanning will
resume. Scanning may be stopped by selecting Stop.

NOTE: Put the multifed document(s) into the input elevator before
selecting Rescan.

Speaker icon — displays the Open dialog box allowing you to select
the desired tone (.wav file) for your alarm.
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Patch tab Patch Readers can automatically sense predefined patch code(s) and
be configured to control document level changes.

Droperties for KODAK i|

Preset: [Defaut]

I Debug Iﬂbout |

Fatch Detection

Fatch Confirmation Taone

Patch Confirmation Tone — the confirmation tone may be used to
signal that a patch has been recognized by the scanner.
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Imprinter tab The Enhanced Printer operates at full scanner speed. The printer can
add a date, time, document sequential counter, and custom messages.

The print string can be configured to include both literal (static)
information (e.g., information that stays the same for each document,
such as batch name or operator) and dynamic information (e.g.,
information that may change for each page scanned, such as the
document sequential counter). The capture software application
controls static fields; any information that the software allows you to
enter can be sent to the printer. You can print on the physical sheet of
paper, or stamp a digital image, or both. For printing on the paper:

_
Properties for KODAK i4250 on N &x\

Preset: [Default][2]

| Scanner I Multifeed Detection | Imprirter | Log I About |

' Digital Stamp
Mode: Offzet from Image's Left:
[ Front side ~] o
Format Template:
L]

Date Time
Format: Delirniter: Format:
[MMDDYvY ] [None -]  [HHmm -
Counter Top Margin:
Field idth: a = Uin
Format: Urits:
[ =

. Font:
Increment;
(Every Sheet =
Beset: Rotation
i v] [ 90 Degrees v]
Reset value: 1 = a

Example:
[ ok ][ cenced |[ Hep |[ Defautt |

Imprinter — turns digital printing on for the physical sheet of paper.
For digital stamping:

* Mode
- Disabled
- Front Side — turns digital printing on for all front images.
- Back Side — turns digital printing on for all rear images.

NOTES:

« Digital stamp is applied to the image after it has been cropped and
rotated. Therefore, if Front Side and Back Side are both enabled,
the print may be printed on different edges of the document.

 Digital stamp is applied before Image Merge so if Back Side is
enabled, the digital print will be printed on the merged image twice.
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Offset for Image’s Left — select a value to determine how far the
printed information will appear from the left edge of the document.

Format Template — the format template is used to build the print
string. The print string is what is printed on documents as they travel
through the transport. The print string is printed before the document is
scanned, therefore, it is part of the image. The maximum amount of
characters for each print string is 40 characters (including spaces).

Date
e Format:

- MMDDYYYY

- MMDDYY

- DDMMYYYY

- DDMMYY

- YYYYMMDD

- YYMMDD

- DDD (Julian)

- YYYYDDD (Julian)
- YYDDD (Julian)

» Delimiter: (the examples indicate a format of YYYYMMDD)

- None

- Slash: 2010/08/24

- Hyphen: 2010-08-24
- Period: 2010.08.24
- Space: 2010 08 24

e Time:

- HHmm

- HHmmss
HHmMmMss.xx
- hhmm
hhmmss
hhmmss.xx
hhmm tt
hhmmss tt
hhmmss.xx tt
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Counter — if you want to add a Counter to the print string, you can
enter one of the following options:

e Field Width: used to control the width of the document counter.
Values range from 1 to 9.

* Format — allows you to configure the format of the counter when the
width of the value is less than the field width (the examples indicate a
field width of 3 and the counter at 4). Options are:

- Display Leading Zeros (default): “004”
- Suppress Leading Zeros: “4”
- Compress Leading Zeros: * 4

* Increment, Reset and Reset value are only for the Kodak i4850
Scanner.

- Increment: allows you to configure when the counter is
incremented.

* Every Sheet

e Patch Type T
e Patch Type 1
» Patch Type 2
» Patch Type 3
» Patch Type 6

- Reset: allows you to configure when the counter is reset.
* Never
o Patch Type T
e Patch Type 1
* Patch Type 2
e Patch Type 3
» Patch Type 6
- Reset value: allows you to select the value for the counter when
it is reset.

When the counter is reset, you can reset the value from 0 to
999,999,999. However, the maximum value is limited by the number
of digits you enter (e.g., if the maximum number of digits is 3, then
the maximum value you can set is 999). The default is 1.

NOTES:

» Patch patterns in the i4850 Scanner are read vertically and they must
be in the first 2 inches of the page.

» When using the Increment option, every page will be printed and the
counter will be incremented on the page after the patch page.
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Top Margin — select a value for the distance from the top edge of the
document.

NOTES:

* Printing automatically stops 6.3 mm (1/4-inch) from the trailing edge
of the document even if the information has not been completely
printed.

» The horizontal print position is determined by the location of the ink
cartridge in the scanner. See the User’s Guide for information about
setting print positions.

» This option is only available when printing on the physical sheet of
paper.

Units — select Inches, Centimeters or Pixels.

» Font — you can select what orientation you want your information to
be printed.

- Style: available character styles: Normal, Large and Bold.

e e T
o Ak I
. Y ™

Normal: 90° rotation Large: 90° rotation Bold: 90° rotation

- Digital Print examples

Normal: 90° Bold: 90° Extra Bold: 90°
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Rotation — you can select either 0 or 90 degrees.

- Orientation: while the characters are printed vertically (starting at
the lead edge of the document) this allows you to select the
orientation of the print string. Available options are: 0, 90, 180, 270.

Feed
Direction 0 a0 180 270

T

(@l=~kd
o8Y
<ol
ABC

Imprinter Format table

Specifier Modifier [Description

None Inserts the current value of the sequential counter.

0 Optional. Formats the counter to be left-padded with zeros to fill the defined field width.
Example: %0S

1-9 Optional. Defines the field width used to print the counter. If the 0 modifier is used, this
field will be left-padded with zeros. Otherwise, it will be left-padded with spaces.
Examples: %7S, %05S

# n/a Same as %S but cannot be formatted.

%S

Inserts the current time in HH:mm format

Optional. Default. Sets the time format to HHmmss

Optional. Sets the time format to HHmmss.nn

Optional. Sets the time format to hhmm

%T Optional. Sets the time format to hhmmss

Optional. Sets the time format to hhmmss.nn

Optional. Sets the time format to hhmm t

Optional. Sets the time format to hhmmss tt

Optional. Sets the time format to hhmmss.nn tt
Inserts the current date format to MMDDYYYY
Optional. Sets the date format to MMDDYY
Optional. Sets the date format to DDMMYYYY
Optional. Sets the date format to DDMMYY
Optional. Sets the date format to YYYYDDMM
Optional. Sets the date format to YYMMDD
Optional. Sets the date format to DDD
Optional. Sets the date format to YYYYDDD
Optional. Sets the date format to YYDDD

_ Optional. Sets the date delimiter to the space character. Can be used with or without a
(underscore) |date format specifier but cannot precede it. Examples: % _Y, %2_Y

%Y

OO N W|INIRPIOOIN[O|O| B[ W[IN]|PF

- Optional. Sets the date delimiter to the dash character.

/ Optional. Sets the date delimiter to the slash character

Optional. Sets the date delimiter to the dot character
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Log tab The Log tab provides a listing of any errors that have been
encountered.

Preset: [Default)[?]

|Scanner I Muttifeed Detection I Patch I Irnprirlterl Log | Debug Iﬂbout |

KODAK 14250 on Hone

You can view the Operator and Meter logs and save this information to
a file by copying the information to the clipboard then pasting it into a
document or you can Save all the logs.
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Save As: saves all the logs for viewing by support personnel. When
selected, a save window will be displayed:

f Save As [&J

Desgcription:

Folder:

Include Debug Images

oK || Cancel |

» Description: enter a brief description of problem/reason for saving
the logs.

» Folder: the location to save the logs.

» Browse: displays the operating system’s Browse for Folder window
so you can find the folder that you want to use.

* Include debug images: includes any generated debug images with
the logs. This should only be turned on when recommended by
support personnel.

OK: saves the file into an eklog file.

The scanner error log can be saved to a file by clicking the Save icon,
or copy the information to the clipboard which can then be pasted into a
document.

1
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Debug tab The Debug tab allows you to turn on options that allow support
personnel to diagnose any issues you may encounter when using your
scanner. It is suggested that you only make changes on this tab when
instructed by Technical Support.

Preset: dk[2]

|Scanner I Multfeed Detection I Patch I Imprinter I Log | Debug |Ab0|_rt |

Logging

On
Imaages

Beceived from scanner

Sent to application

Logging — saves the communications between the scanner and a
scanning application. The options are: Off or On.

Images
* Received From Scanner: saves the images received at the PC from

the scanner.

» Sent To Application: saves the images received at the scanning
application from the scanner.
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